
INSTALLATION INSTRUCTIONS

NI SCXI -1379
Terminal Block for the NI SCXI-1130

This guide describes how to install and connect signals to the 
National Instruments SCXI-1379 terminal block to configure the 
SCXI-1130 as an 8x32, 1-wire matrix.

The SCXI-1379 terminal block, which installs in front of the SCXI-1130 
switch module, uses screw terminals to connect signals and the trigger 
input and trigger output signals to the switch. 

Refer to the NI Switches Getting Started Guide to determine when to install 
the terminal block.

Conventions
The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names and information on hardware labels.
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italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.

1. Unpack the Terminal Block
To avoid damage when you handle the terminal block, take the following 
precautions:

Caution Never touch the exposed pins of connectors. 

• Ground yourself using a grounding strap or by touching a grounded 
object.

• Touch the antistatic package to a metal part of the chassis before you 
remove the terminal block from the package.

Remove the terminal block from the package and inspect the terminal block 
for loose components or any sign of damage. Notify NI if the terminal 
block appears damaged in any way. Do not install a damaged terminal 
block on a switch module.

Store the terminal block in the antistatic package when not in use.

2. Verify the Components
Make sure that you have the following items:

❑ SCXI-1379 terminal block

❑ SCXI chassis

❑ SCXI-1130 switch module

❑ 1/8 in. flathead screwdriver

❑ Phillips screwdriver

❑ Wire cutter

❑ Wire insulation stripper
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❑ Matrix expansion cable (to expand the columns of a matrix)

❑ Matrix expansion plug (to expand the rows of a matrix)

Tip NI recommends using 28 AWG wire (ribbon or discrete) for use with the SCXI-1379 
terminal block.

3. Connect Signals
To connect signals to the terminal block, refer to Figures 1 and 2 while 
completing the following steps:

1. Prepare the signal wire by stripping the insulation no more than 7 mm.

2. Remove the top cover screw.

3. Unsnap and remove the top cover.

4. Loosen the two strain-relief screws on the strain-relief assembly.

5. Run the signal wires through the strain-relief opening. 

6. Insert the stripped end of the wire fully into the terminal. Secure the 
wire by tightening the screw of the terminal. No bare wire should 
extend past the screw terminal. Exposed wire increases the risk of 
a short-circuit induced failure.

Note When connecting signals to the SCXI-1379, refer to Table 1 to determine where to 
connect signals for the 8x32, 1-wire matrix topology.

7. Tighten the two screws on the strain-relief assembly to secure the 
cables.

8. Reinstall the top cover.

9. Replace the top cover screw.
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Figure 1.  SCXI-1379 Terminal Block

1 Terminal Block Top Cover
2 Signal Wires
3 Safety Ground Lug
4 Screw Terminals
5 Column Connector
6 Rear Connectors
7 Top Cover Screw

8 Thumbscrew
9 Column Connector
10 Strain-Relief Screw
11 Strain-Relief Bar
12 Strain-Relief Opening
13 Row Connector
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Figure 2.  SCXI-1379 Terminal Block Signal Connections
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Table 1.  8x32, 1-Wire Matrix Topology Mapping

Software Hardware Software Hardware Software Hardware

r0 ROW 0 c6 COLUMN 6 c19 COLUMN 35

r1 ROW 1 c7 COLUMN 7 c20 COLUMN 36

r2 ROW 2 c8 COLUMN 8 c21 COLUMN 37

r3 ROW 3 c9 COLUMN 9 c22 COLUMN 38

r4 ROW 4 c10 COLUMN 10 c23 COLUMN 39

r5 ROW 5 c11 COLUMN 11 c24 COLUMN 40

r6 ROW 6 c12 COLUMN 12 c25 COLUMN 41

r7 ROW 7 c13 COLUMN 13 c26 COLUMN 42

c0 COLUMN 0 c14 COLUMN 14 c27 COLUMN 43

c1 COLUMN 1 c15 COLUMN 15 c28 COLUMN 44

c2 COLUMN 2 c16 COLUMN 32 c29 COLUMN 45

c3 COLUMN 3 c17 COLUMN 33 c30 COLUMN 46

c4 COLUMN 4 c18 COLUMN 34 c31 COLUMN 47

c5 COLUMN 5
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4. Expanding Rows & Columns
The SCXI-1379 terminal block offers convenient methods for expanding 
the rows and/or columns of a matrix using two or more SCXI-1379 
terminal blocks. If you are not expanding the rows or columns of the 
matrix, skip to the Install the Terminal Block section. For more information 
about expanding matrices, refer to the NI Switches Help.

Row Expansion
Figure 3 shows how to expand the rows of a 4x32 matrix using a matrix 
expansion plug. The matrix expansion plug connects columns to expand 
the rows. To expand the rows of a matrix, complete the following steps:

1. Connect two SCXI-1379 terminal blocks to the front connectors of the 
two adjacent SCXI-1130 modules.

2. Tighten the top and bottom chassis screws on the back of the terminal 
block rear panels to hold them securely in place.

3. Connect a matrix expansion plug to the top or bottom column 
connectors of the two SCXI-1379 terminal blocks.

 

Figure 3.  Row Expansion with the SCXI-1379
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Column Expansion
Figure 4 shows how to expand the columns of a 4x32 matrix using a matrix 
expansion cable. The matrix expansion cable connects rows to expand the 
columns. To expand the columns of a matrix, complete the following steps:

1. Connect one end of the matrix expansion cable to one of the ROW 
CONNECTION CABLE terminals in one of the SCXI-1379 terminal 
blocks.

2. Connect the other end of the matrix expansion cable to one of the ROW 
CONNECTION CABLE TERMINALS in another SCXI-1379.

3. Connect the two SCXI-1379 terminal blocks to the front connectors of 
the two SCXI-1130 modules.

4. Tighten the top and bottom chassis screws on the back of the terminal 
block rear panels to hold them securely in place.

 

Figure 4.  Column Expansion with the SCXI-1379
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5. Install the Terminal Block
To connect the SCXI-1379 terminal block to the SCXI-1130 front panel, 
refer to Figure 5 and complete the following steps (the SCXI-1130 should 
already be installed in an SCXI chassis):

1. Plug the SCXI-1379 onto the front connectors of the SCXI-1130.

2. Tighten the top and bottom thumbscrews on the back of the terminal 
block rear panel to hold it securely in place.

 

Figure 5.  Installing the SCXI-1379 Terminal Block
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Compliance and Certifications

Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, 
and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 3111-1, UL 61010B-1

• CAN/CSA C22.2 No. 1010.1

Note For UL and other safety certifications, refer to the product label, or visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 
Table 1

EMC/EMI ...............................................CE, C-Tick, and FCC Part 15 
(Class A) Compliant

Note For EMC compliance, you must operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility 
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on 
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are 
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location: 
Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.

© 2003–2007 National Instruments Corporation. All rights reserved. 373691B Nov07



取り付け手順

NI SCXI -1379
NI SCXI-1130 用端子台

このガイドでは、ナショナルインスツルメンツ製 SCXI-1379 端子台の取

り付けおよび信号の接続方法、また SCXI-1130 を 8 × 32 単線式マトリク

スに構成する方法について説明します。

SCXI-1130 スイッチモジュールの前面に取り付ける SCXI-1379 端子台は、

ネジ留め式端子を使用して信号およびトリガ入出力信号をスイッチに接続

します。 

端子台を取り付ける順番については、『NI スイッチスタートアップガイ

ド』を参照してください。

表記規則

このドキュメントでは、以下の表記規則を使用します。

→ 矢印（→）は、ネスト化されたメニュー項目やダイアログボックスのオプ
ションをたどっていくと目的の操作項目を選択できることを示します。 た
とえば、ファイル→ページ設定→オプションとなっている場合は、ファイ
ルメニューをプルダウンして、ページ設定項目を選択し、最後のダイアロ
グボックスからオプションを選択します。

このアイコンは、ユーザへのアドバイスを示します。

このアイコンは、注意すべき重要な情報があることを示します。

このアイコンは、負傷、データの損失、システムの破損を防止するための
注意事項を示します。

太字 太字のテキストは、メニュー項目やダイアログボックスのオプションな
ど、ソフトウェアで選択またはクリックする必要がある項目を表します。 
また、太字のテキストは、パラメータ名およびハードウェアラベルにも使
用されます。

™
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斜体 斜体のテキストは、変数、強調、または重要な概念の説明を示します。 
また、入力する必要のある文字列や値を表すこともあります。

monospace このフォントのテキストは、キーボードから入力する必要があるテキスト
や文字、コードの一部、プログラムサンプル、構文例を表します。 また、
ディスクドライブ、パス、ディレクトリ、プログラム、サブプログラム、
サブルーチンなどの名称、デバイス名、関数、操作、変数、ファイル名お
よび拡張子、コードの引用にも使用されます。

1. 端子台を箱から取り出す

取り扱い中に端子台を破損しないために、以下の予防措置を行ってくださ

い。

注意 露出しているコネクタピンには絶対に触れないでください。 

• 接地ストラップを使用したり、接地された物体に触れて、身体を接地

する。

• 静電気防止用パッケージをシャーシの金属部分に接触させてから、

端子台をパッケージから取り出す。

端子台を箱から取り出し、部品がゆるんでいないかどうか、また、破損箇

所がないかどうか調べます。 端子台が破損している場合は、ナショナルイ

ンスツルメンツまでご連絡ください。 破損している端子台をスイッチモ

ジュールに取り付けないでください。

端子台は、使用しないときは静電気防止用パッケージに入れて保管してく

ださい。

2. 部品を確認する

下記の部品があることを確認します。

❑ SCXI-1379 端子台

❑ SCXI シャーシ

❑ SCXI-1130 スイッチモジュール

❑ 1/8 in. マイナスドライバー

❑ プラスドライバー

❑ ワイヤカッター

❑ ワイヤストリッパー
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❑ マトリクス拡張ケーブル（マトリクスの列拡張用）

❑ マトリクス拡張プラグ（マトリクスの行拡張用）

ヒント NI では、SCXI-1379 端子台との使用に 28 AWG ワイヤ（リボンまたは単線式）

の使用を推奨しています。

3. 信号を接続する

端子台に信号を接続するには、図 1 および図 2 を参考に次の手順に従い

ます。

1. 信号線の絶縁被覆を取り除きます（7 mm 以内）。

2. 上部カバーのネジを外します。

3. 上部カバーを取り外します。

4. ストレインリリーフアセンブリにある 2 つのストレインリリーフ用

ネジを緩めます。

5. 信号線をストレインリリーフの開いた部分に通します。 

6. 被覆を取り除いたワイヤの端を端子に挿入します。 端子に付いている

ネジを締めてワイヤを固定します。 裸線がネジ端子の外に露出しない

ように注意してください。 ワイヤが露出しているとショートする可能

性があり、正しく作動しない場合があります。

メモ SCXI-1379 に信号を接続する場合、表 1 を参照して 8 × 32、単線式マトリクス

トポロジでの信号接続位置を確認します。

7. 2 つのストレインリリーフ用ネジを締めて、ケーブルを固定します。

8. 上部カバーを取り付けます。

9. 上部カバーのネジを取り付けます。
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図 1 SCXI-1379 端子台

1 端子台の上部カバー

2 信号線

3 安全接地用つまみ

4 ネジ留め式端子

5 コネクタ（列）

6 後部コネクタ

7 上部カバーのネジ

8 つまみネジ

9 コネクタ（列）

10 ストレインリリーフ用ネジ

11 ストレインリリーフバー

12 ストレインリリーフバー間の隙間

13 コネクタ（行）
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図 2 SCXI-1379 端子台の信号接続
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表 1 8 × 32、単線式マトリクストポロジマッピング

ソフト

ウェア ハードウェア

ソフト

ウェア ハードウェア

ソフト

ウェア ハードウェア

r0 ROW 0 c6 COLUMN 6 c19 COLUMN 35

r1 ROW 1 c7 COLUMN 7 c20 COLUMN 36

r2 ROW 2 c8 COLUMN 8 c21 COLUMN 37

r3 ROW 3 c9 COLUMN 9 c22 COLUMN 38

r4 ROW 4 c10 COLUMN 10 c23 COLUMN 39

r5 ROW 5 c11 COLUMN 11 c24 COLUMN 40

r6 ROW 6 c12 COLUMN 12 c25 COLUMN 41

r7 ROW 7 c13 COLUMN 13 c26 COLUMN 42

c0 COLUMN 0 c14 COLUMN 14 c27 COLUMN 43

c1 COLUMN 1 c15 COLUMN 15 c28 COLUMN 44

c2 COLUMN 2 c16 COLUMN 32 c29 COLUMN 45

c3 COLUMN 3 c17 COLUMN 33 c30 COLUMN 46

c4 COLUMN 4 c18 COLUMN 34 c31 COLUMN 47

c5 COLUMN 5
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4. 行および列を拡張する

SCXI-1379 端子台を使用して、マトリクスの行と列を簡単に拡張するこ

とができます。 マトリクスの行および列を拡張しない場合は、「端子台の

取り付け」セクションに進んでください。 マトリクスの拡張に関する詳細

は、『NI スイッチヘルプ』を参照してください。

行の拡張
図 3 は、マトリクス拡張プラグを使用した 4 × 32 マトリクスの行の拡張

方法を示します。 マトリクス拡張プラグを列に接続して行数を拡張しま

す。 マトリクスの行数を拡張するには、次の手順に従います。

1. 2 台の SCXI-1379 端子台を 2 台の隣り合った SCXI-1130 モジュール

のフロントコネクタに接続します。

2. 端子台の後部パネル背面にある上下のシャーシ用ネジを締めて、端子

台をしっかりと固定します。

3. 2 台の SCXI-1379 端子台の上部または底部にある列コネクタにマト

リクス拡張プラグを取り付けます。
 

図 3  SCXI-1379 を使用した行の拡張

1 マトリクス拡張プラグ 2 つまみネジ 3 コネクタ（列）
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列の拡張
図 4 は、マトリクス拡張ケーブルを使用した 4 × 32 マトリクスの列の拡

張方法を示します。 マトリクス拡張ケーブルを行に接続して列数を拡張し

ます。 マトリクスの列数を拡張するには、次の手順に従います。

1. マトリクス拡張ケーブルの一方の端を、1 台の SCXI-1379 端子台の

ROW CONNECTION CABLE 端子の 1 つに接続します。

2. マトリクス拡張ケーブルのもう一方の端をもう一台の SCXI-1379 端

子台の ROW CONNECTION CABLE 端子の 1 つに接続します。

3. 2 台の SCXI-1379 端子台を 2 台の SCXI-1130 モジュールのフロント

コネクタに接続します。

4. 端子台の後部パネル背面にある上下のシャーシ用ネジを締めて、端子

台をしっかりと固定します。
 

図 4  SCXI-1379 を使用した列の拡張

1 SCXI-1379
2 マトリクス拡張ケーブル

3 ROW CONNECTION CABLE 端子
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5. 端子台を取り付ける

SCXI-1379 端子台を SCXI-1130 フロントパネルに接続するには、図 5 を

参照して、次の手順を行ってください（SCXI-1130 は既に SCXI シャーシ

に取り付けられている状態）。

1. SCXI-1379 を SCXI-1130 のフロントコネクタにはめ込みます。

2. 端子台の後部パネル背面にある上下のつまみネジを締めて、端子台を

しっかりと固定します。
 

図 5 SCXI-1379 端子台を取り付ける

1 つまみネジ

2 フロントコネクタ

3 SCXI-1130
4 SCXI-1379

4

1

3

2



NI SCXI-1379 取り付け手順 10 ni.com/jp

認可および準拠

安全性
この製品は、計測、制御、実験に使用される電気装置に関する以下の安全

規格の必要条件を満たすように設計されています。

• IEC 61010-1、EN 61010-1

• UL 3111-1、UL 61010B-1
• CAN/CSA C22.2 No. 1010.1

メモ UL および準拠する安全規格については、製品ラベルを参照するか ni.com/

certification（英語）にアクセスして型番または製品ラインで検索し、保証

の欄の該当するリンクをクリックしてください。

電磁両立性
エミッション（不要輻射）............................ EN 55011 Class A（10 m）、

FCC Part 15A（1 GHz 以上）

イミュニティ（電磁環境耐性）................... EN 61326:1997 + A2:2001、
Table 1

EMC/EMI ..........................................................CE、C-Tick、および

FCC Part 15（Class A）適合

メモ EMC に適合させるには、このデバイスと一緒に必ずシールドケーブルを使用し

てください。

CE 適合
この製品は、以下のように、CE マーク改正に基づいて、該当する EC 理

事会指令による基本的要件に適合しています。

低電圧指令（安全性）.................................... 73/23/EEC

電磁両立性 
規格 (EMC)....................................................... 89/336/EEC

メモ この製品のこのほかの適合規格については、この製品の適合宣言 (DoC) を参照

してください。 この製品の適合宣言を入手するには、ni.com/certification

（英語）にアクセスして型番または製品ラインで検索し、該当するリンクをク

リックしてください。



 

National Instruments、NI、ni.com、および LabVIEW は National Instruments Corporation
（米国ナショナルインスツルメンツ社）の商標です。National Instruments の商標の詳細については、
ni.com/legalの「Terms of Use」セクションを参照してください。本文書中に記載されたその他の
製品名および企業名は、それぞれの企業の商標または商号です。National Instruments の製品を保護
する特許については、ソフトウェアに含まれている特許情報（ヘルプ→特許情報）、CD に含まれている
patents.txtファイル、または ni.com/patentsのうち、該当するリソースから参照してください。

© 2003–2007 National Instruments Corporation. All rights reserved. 373691B-01 2007 年 11 月
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